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Preface

Welcome

Thank you for purchasing Internet Phone™ Release 5, the latest version of
VocalTec's award winning software. We are pleased to welcome you to our
growing worldwide family of Internet Phone users who have discovered how to
enjoy long-distance communication without paying long-distance bills.

How to Use This Manual

This easy-to-read user manual is intended to serve as an introduction to the
software, covering important features in a step-by-step process.

The Internet Phone user manual contains the following chapters:
*  Chapter 1 gives you a brief introduction of the main features of Internet
Phone. You should read this chapter first, if you are new to the product.

*  Chapter 2 describes how to install and start Internet Phone.

*  Chapters 3 describes how to make calls, accept calls, and conduct
conversations.

*  Chapter 4 describes how to locate people to call, browse and create chat
rooms using the Community Browser™.

*  Chapter 5 describes how to call a regular phone over the Internet from your
computer and how to create your own Personal Directory.

*  Chapter 6 describes how you can transmit and receive video, send and receive
voice mail, share documents and images with others using the Whiteboard,
use the Text Chat and exchange files easily using the File Transfer feature.

o Appendix A describes the Parental Control issue.

e Appendix B gives a list of answers to Frequently Asked Questions
and troubleshooting,

*  Appendix Cis a quick reference of the Internet Phone window icons and
symbols.

*  Glossary of terms.

e Index.



Preface Welcome

If You Have a Problem

Before calling VocalTec for technical support on a specific problem try the
following:

Use the on-line help, to see if there is a fix for the problem you are
experiencing,

Consult the release notes (readme.htm) for late-breaking news that did not
make this manual before press time.

Choose Technical Support from the Internet Phone Help menu to find
easy solutions to common problems.

If you have a problem with audio record and playback, use the
Audio>Test... option on the Options menu.

If, after following these procedures you still need to contact VocalTec technical
support, please follow these guidelines:

Have your product license code number ready. Support requests cannot be
processed without one. You can find your product license code number in
the About dialog box or on the first page of this manual.

E-mail support provides the fastest method of feedback.

VocalTec has established several forms of support. Choose the method that suits
you best from the following:

Choose Support Wizard from the Internet Phone Help menu. Send a
support request to VocalTec’s technical support. Please make sure to include
a detailed description of your problem.

Send an e-mail message with the details of your problem to

supporf@uocaltec.com.
Call our technical support at 201-768-9400

Product and General Information

Choose Customer Services from the Internet Phone Help menu to receive
updated information and easy solutions to common problems.

Look for the latest company information, product releases, and news on our
Web site, at www.vocaltec.com.



Chapter 1
Introduction

Internet Phone™ Release 5 sets the new standard in Internet communication
software with enhanced audio and video quality and a revolutionary

Internet Phone-to-Telephone calling feature. With its expanded suite of
multimedia features, such as a live video, voice mail, a whiteboard, text chat and file
transfer, Release 5 provides a comprehensive solution for your Internet/Intranet
communication needs.

The new Community Browser™ makes it easy to find people with similar interests
from around the world.

Whether you're calling a family member, business associate ot just looking for a
new friend in another part of the world, Internet Phone will connect you in a way
you never thought possible. Now, more than ever, there is no need to worry about
long distance, the whole wotld is just a local call away!
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Chapter

2

Installing Internet Phone

This chapter describes how to install and start Internet Phone™. Before starting,
make sure your system meets the minimum system requirements.

To be able to call people and to receive calls you must connect to the Internet, see
“Running Internet Phone” on page 13.

Minimum System Requirements

Before starting, make sure your system meets the following minimum

requirements:

Pentium processor 75 MHz or higher
16 MB RAM
Windows 95 or Windows NT 4.0 or higher

32-bit Winsock Internet TCP/IP connection, SLIP or PPP; 14.4kbps
(28.8kbps recommended)

Windows-compatible sound card

(A full-duplex sound card is needed for full-duplex mode)
Microphone and speakers

Windows-compatible video capture device
(only needed to send video)

For a better display of the Community Browser™, it is recommended
to install Microsoft Internet Explorer.

You may skip this recommendation if Microsoft Internet Explorer 3 or
higher version is already installed on your computer.




Chapter 2 Installing Internet Phone

Installation
To install Internet Phone

1 Download Internet Phone Release 5 and select a directory to save the file in.
Run the self-extract file from the directory you saved it in.

2 During the setup program, enter the requested information in the dialog
boxes.

3 When you want to continue to the next dialog box, click the Next button.

Entering your Personal Information

During the setup process, you will be asked to enter your personal information and
your license code. In the dialog box, type your personal information.

You need to enter at least your Nicknamse. It should include up to 9 characters
without spaces or other special characters.

Entering Your License Code

Type your license code in the License Code text box exactly as it appears - i.e.,
type all the dashes, slashes or any other symbol.

The license code is required to use Internet Phone regularly. Without it, Internet
Phone will only function as a limited version.

It is possible to install your License Code from within Internet Phone. To do this,
choose Install License... from the Help menu.

N O TE Installing your license code would enable you to use the
Internet Phone-to-Telephone calling services offered only to licensed
users of Internet Phone; see “Web Setup” on page 11.

10



Web Setup Chapter 2 Installing Internet Phone

Additional Personal Details

In the next dialog box, type additional personal information. Please note that this
information will be viewed by other users on the Community Browser and during a
conversation.

In order to use the Voice Mail feature it is imperative you enter your e-mail address
in the E-mail text box. If you do not want to show your e-mail address to other
users but you want to use the Voice Mail feature please check the Use e-mail for
Voice Mail only. Do not show it to others checkbox.

In the Comment field, you can add a short remark about yourself.

TIP It is possible to change your personal information from within Internet
Phone. To do this, choose Personal Information from the Options
menu.

Enterin g Your Internet Connection Speed

In the next step of the setup process, select your Internet access or modem speed
to enable the optimal use of bandwidth for audio and video communication over
the Internet.

Web Setup

After the software installation is completed, you will have the option to continue
the setup on the Web. Choosing to do so will bring you to the Internet Phone
Customer Services page.

NOTE You need to connect to the Internet in order for this option to work.
For more information on how to connect to the Internet;
see “Running Internet Phone” on page 13.

If you have installed your license code, follow the instructions on your screen to
join services such as the Telephony Services and the Addressing Service. Register as an
Internet Phone user and you will be able to receive special information, news,
software updates and other benefits.

11
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Choosin g an Internet Telephony Service Provider

One of the new features of Internet Phone Release 5 is the Telephony Service -
Internet Phone-to-Telephone calling service. This service expands your communication
capabilities by enabling you to call a regular telephone from your computer using
Internet Phone; see “Calling a Regular Phone” on page 33.

Just as you need to register with an Infernet Service Provider (ISP) in order to connect
to the Internet, you must select an Internet Telephony Service Provider ITSP) in order
to call a regular telephone from your computer. The Internet Phone Customer
Services page contains a list of ITSPs from which you can choose a provider who
will supply your connection to the public telephone network. Follow the
instructions on your screen to choose and then register with an I'TSP.

TIP It is possible to register with an I'TSP later from within Internet Phone.
To do this, choose Telephony Services from the Help menu and
follow the on-screen instructions.

Internet Phone Re gistration

By registering as an Internet Phone user, you will be able to receive special
information, news, software updates and other benefits. As an additional bonus,
you can join to VocalTec's Addressing Service, which will enable others to locate
you at greater ease. Follow the on-screen instruction to register as an Internet
Phone user.

Joinin g the Addressin g Service

12

The Addressing Service allows other Internet Phone users to call you using your
unique Internet Phone address. People that have joined the Addressing Service can
also contact you using your e-mail address, which you should type correctly during
the registration process in the on-line registration form, see “The Addressing Service”
on page 37.

TIP  Itis possible to register and join the Addressing Service later from
within Internet Phone. To do this, choose Addressing Services
from the Help menu and follow the on-screen instructions.




Running Internet Phone Chapter 2 Installing Internet Phone

Runnin g Internet Phone

After the software installation is completed, you can run Internet Phone. To be
able to call people and to receive calls you must connect to the Internet via a direct
Internet connection, ot via a modem SLIP/PPP connection of 14,400 bps ot faster
(see “Mininum System Requirements” on page 9.) You can also run it on a TCP/IP LAN.
If you are using a modem, make sure it is working and properly connected to the
Internet.

To run Internet Phone

* Click the Start button, point to Programs and Internet Phone 5, and then
click Internet Phone 5.

TIP  You can keep Internet Phone running in the background and start it
whenever you want by double-clicking its taskbar tray icon at the right
bottom of Windows desktop.

Internet Phone 5

[
ﬂ@ﬂ 11:25 &k taskbar tray icon

e

To quit Internet Phone

¢  Choose Exit from the Phone menu.

When you quit Internet Phone, the current settings are automatically saved and
used the next time you run the program.

Settin g Up the Audio

The first time you run Internet Phone, the Audio Test window appears. Use it to test
your audio configuration and to make sure your microphone and sound card are
set up correctly.

13



Chapter 2 Installing Internet Phone

To perform the audio test

1 Click the Start Test button and speak into your microphone for a few
seconds.

2 Stop speaking, then listen to your recording as it plays back automatically.

If your microphone is connected propetly and your sound card is propetly
installed, you should hear yourself speaking through your speakers during playback.
If you do not hear yourself, check your sound card configuration and that your
microphone and speakers are connected properly. Adjust the playback level by
dragging the playback slider to the desired volume.

TIP  You can change your audio settings from within Internet Phone by
pointing to Audio in the Options menu and clicking Test....

Settin g Up the Video

14

Internet Phone Release 5 supports various video capture devices (e.g., a camera or
camera and video capture card combination) that allow you to transmit video
images to others.

NOTE If you do not have a video capture device you cannot transmit video,
however, you can still receive video from another user. You may skip
this section, as it is relevant only to people with a video capture device.

Before you begin using Internet Phone, make sure your video capture device is
propetly connected by choosing Self View from the Options menu. A video
capture window is displayed, and you should be able to view what the video device
is directed at; if not, check your video connection.

You should also perform the 7deo Test to confirm that your Self View and
transmitted video are functioning propetly.



Setting Up the Video Chapter 2 Installing Internet Phone

To perform the video test

1 Point to Video in the Options menu and choose Preferences.
2 Click the Video Test tab.

3 Click the Start Test... button.
Two windows are displayed - the Source window displaying the video as
sampled by your video device and the Owfput window displaying the video
quality and speed you will send to the remote user after video compression.

4 Drag the Quality slider to adjust the quality and frame rate of your
transmitted video. If the quality is higher, the video speed is slower. If the
quality is lower, the video speed is higher.

15
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Chapter 3

Using Internet Phone

Internet Phone window is the communication tool for making calls.
The Community Browser™ is a real-time directory of on-line Internet Phone users.

Open the Community Browser and use it to select users to call.
Conduct the conversation from the Internet Phone window.

The Internet Phone Window

The Internet Phone window provides tools for making a call and performing other
calling functions. In the Internet Phone window, you can:

* Call other people by typing their e-mail, IP or
Internet Phone address in the Ca// Line.

* Call a regular telephone using the Dialer.

*  Add Multimedia Features to your calls such as
sending and receiving video, voice mail, text chat, 1
whiteboard session, and file transfer; see “Chapter VinralTar

6 Multimedia Sessions” on page 41. B ciiai
* View the Awnimated Assistant for information
about your call. & =
Waiting for cal
* See the User Information of the person you are e ——
speaking with. 8 = d
* Control the Video Settings. Beiber el
[ [vme |

*  See the status of your call in the Message Line.

* Perform calling functions such as_Auswer, Hold, T
Hang Up, answer to Call Waiting, Redial and Return

Call.
* Control the Audio Settings.
* Keep a record of recent calls in the Session list and redial anyone you want.
* Maintain a list of NePals who you may want to call more often.

* Find more information by the Status Indicators, e.g,, do you share data with

17



Chapter 3 Using Internet Phone

the other person, what is your conversation mode (half-, full-duplex), are
you connected to the addressing server and what is your Internet connection
quality; see “Appendix C: Internet Phone Icons” on page 54.

* Click the connection quality indicator to view incoming and outgoing audio
and video Statistics.

The Community Browser Window

The Community Browser window provides access to virtual communities, or chat
rooms, in which you can search for and contact people who share similar interests.

In the Community Browser window, you can:
* Search and call people in Public Chat Rooms, which VocalTec maintains for
Internet Phone usets.

* Search and call people in Menber Chat Rooms that you and other Internet
Phone users create.

* Create your own public or private chat room, adding textual and graphic
web content to supplement the chat room’s topic.

* Create a list of your Favorite chat rooms.
* Search for a person to call in a user directory.

* Participate in an on-line conference.

18



Making Your First Call Chapter 3 Using Internet Phone

Makin g Your First Call e

&,

You are now ready to make your first call.
Perform the following procedure to make an Internet
Phone call from the Community Browser window.

To make your first call

1

2

Run Internet Phone. The Internet Phone window appears on the screen.
Click the Community Browser tool button. &)

In the Community Browser window, you are automatically joined to one of
the Public Chat rooms.

On the left-hand side of the chat room is a list of currently on-line Internet
Phone users. Call a person from the user list in one of the following ways:

* Double-click on the person’s name.
* Right-click on the person’s name and then choose Call.

The call is in progress and Internet Phone Release 5 attempts to reach the
person you selected. The Animated Assistant shows that you are connecting,
and you can hear simulated telephone ringing sounds. If the person accepts
your call, you can have a conversation.

Speak clearly into the microphone. Be careful not to speak too closely to the
microphone, or your voice will sound high and distorted on the other side.
Make sure that the Record Level/ bar in the Audio Settings of the Internet Phone
window is always bright green and does not reach deep into the red zone. If
it does, you are speaking too loudly.

End the conversation in one of the following ways:

*Click the Hang Up button in the Internet Phone window:.

*Point to User in the Phone menu and choose Hang Up.

The conversation ends.

For other ways of making a call; see “Chapter 5 Additional Ways to Make a Call” on page

33.

19



Chapter 3 Using Internet Phone

Conversation Modes

& Full-duplex

%A@ Half-duplex

There are two modes of conversation: Fu/l-Duplex and Half-Duplex. In a full-duplex
conversation, both users can speak at the same time; in a half-duplex conversation,
users take turns speaking.

In order to be able to conduct a full-duplex conversation, both users’ systems must
support full-duplex mode. A full-duplex sound card must be installed. If your
system supports full-duplex mode but the other uset’s system supports only
half-duplex mode, Internet Phone will automatically switch to half-duplex.

During a conversation you can switch between full-duplex and half-duplex mode at
will.

To switch between full-duplex and half-duplex mode

Point to Audio in the Options menu and choose Full Duplex depending on your
requirement:

*  When selected: Full-duplex mode. If both users’ systems support full-duplex,
both of you can speak simultaneously.
*  When cleared: Half-duplex mode - both of you must take turns speaking.

At the bottom of the Internet Phone window, the Conversation Mode icon
displays the current mode (see “Appendix C: Internet Phone Leons” on page 54.)

NOTE If the mode automatically switched to half-duplex because the other
user has only half-duplex capability, the conversation mode icon is
changed, indicating that your system is now in half-duplex mode. This
mode will remain only during the current conversation.

Full-Duplex Conversation

20

During a full-duplex conversation, both you and the other person can speak
simultaneously, just as easily as if you were using a phone. Note that there can be a
short delay before what you say is transferred and played on the other user’s
system.



Conversation Modes Chapter 3 Using Internet Phone

The following events occur in the Internet Phone window:

* The Animated Assistant shows you are talking with each other.

* The Message line indicates the current mode of conversation. The different

modes are:
No one is talking  Talking Listening Both
Nobody is speaking.  What you say is What he or she What you both
You or the other transmitted over says is transmitted  say is transmitted
person can start the Internet to the over the Internet  over the Internet
speaking. other person. to you. to each other.

Half-Duplex Conversation

A half-duplex conversation is identical in nature to a full-duplex conversation,
except for the following:

1 During conversation, you and the other person must take turns speaking
(more like using a ham radio than a telephone).

2 The Animated Assistant and the Message Line supply you with information
about the remote side status. The Message Line indications are as follows:

No one is talking Talking Listening

You can start speaking.  Your voice is being What the other person
transmitted over the says is transmitted over
Internet to the other the Internet to you.
person.

3 You can interrupt the other person in the middle of speech.
Press the Push to Talk button in the Audio Settings area in the Internet
Phone window. Do not release this
. . . ﬁ { —_— Eﬂ
button until you wish to stop talking. Push to Talk= -

N O TE Internet Phone sets full-duplex mode as the default value. To set
half-duplex mode as the default choose Audio>Preferences from the
Options menu. Click the Devices tab and clear the Use Full Duplex to
start Internet Phone in half-duplex mode as the default.

21



Chapter 3 Using Internet Phone

Receivin g a Call

You can easily recognize an incoming call when:

* You hear a telephone ringing sound.

* The Animated Assistant shows that you are receiving a call.

* The Answer button text blinks in red.

* The Message Line displays the message Ringing.

* The caller's user information is displayed in the User Information section.

* A new entry is displayed in the Session list with a ringing telephone icon at
its left.

If you accept the call, the conversation with the other person starts. You can also
see the name of the person who called you on the Internet Phone window title bar.

To accept an incoming call

* Click the Answer button or point to User in the Phone menu and choose
Answer.

* Double-click on the new entry in the Session list.

TIP  The Session list can help you track the calls from other users that arrived
while you were in the middle of another conversation. After you
# disconnect, the names of the people who tried to call you appear on the
Session list with a small grayed icon displayed to the left. You can return
a call to a person by double-clicking on his or her name.

Blocking Calls
E} To block all incoming calls, choose Do Not Disturb from the Phone menu.

The Do Not Disturb icon appears near the Message Line indicating you are in the
Do Not Disturb mode.

Choosing this option allows you to conduct a conversation or perform other
functions without any interruptions.

22



Other Calling Features Chapter 3 Using Internet Phone

You can receive calls from specific people in the NetPals list even if the Do Not
Disturb mode is active. see “INetPals” on page 39.

To disable the Do Not Disturb mode
Do one of the following:

* Click the Do Not Disturb icon. The icon disappears indicating you are no
longer in the Do Not Disturb mode.

¢ C(lear the Do Not Disturb command in the Phone menu.

Other Callin g Features

Call Holding

&

You can put the current session on hold if you want to call or answer someone else
without disconnecting your current call. In the Session list you can maintain several
on-hold sessions and move between them, keeping only one session active while
the rest are on hold. The icon to the left indicates the status of each session.

see ‘Appendix C: Internet Phone Icons” on page 54.

To put the current session on hold

Do one of the following:

* During a conversation, click the Hold button. The text on the Hold button
changes to Resume.

¢ Select another user from the Session list.
To resume a session on hold
Do one of the following:

¢ C(lick the Resume button.

¢ Select a user on hold from the Session list and resume the conversation.

23
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Call Waitin g

G When you are in the middle of a conversation and someone calls you, the text on
the Answer button blinks in red and changes to Ca// Waiting. To answer a waiting
call, click the blinking Call Waiting button. The previous conversation is
automatically put on hold.

Call Mutin g
B To mute your microphone, click the microphone icon on the Audio Settings.

Choosing this option when you are in a full-duplex mode prevents picking up
background noise and interrupting the other person while he or she is speaking.

24



Chapter 4

Exploring the Community Browser

The Community Browser™ makes it easy for you to locate and call people. In the
Community Browser, you can gain access to chat rooms covering a wide range of
subjects to find Internet Phone users to call. You may also search for a specific user
using the Community Browser Find option.

A Chat Room is an interactive environment which functions as a “virtual
community”. Each chat room contains a list of users from which you can select a
person to call. At the same time, you view a chat room’s graphic and textual Web
content, which adds interesting and fun aspects to the conversation.

Usin g the Community Browser
& To open the Community Browser
Do one of the following:

* In the Internet Phone window, choose Community Browser... from the
Go menu.

* In the Internet Phone window, click the Community Browser button at
the right of the Call Line.

The Community Browser window appears.

TIP  If you want to open the Community Browser window each time you
run Internet Phone, choose Preferences from the Options menu
in the Internet Phone window. Select the General icon and click the
Display tab. Check the Open Community Browser on Startup
checkbox and click the OK button.

When you open the Community Browser for the first time, you automatically join
one of the Public Chat rooms, and your personal information is displayed as an
entry in the user list. Each entry in the user list represents an Internet Phone user
and includes his or her personal information such as Nicknane, Comment and
Country.

25



Chapter 4 Exploring the Community Browser

When you open the Community Browser window at other times, you will join, by
default, the last chat room that you were in before you logged off. If you want, you
can choose to Auto Join a Favorite chat room; see “I'he Favorites 1VView” on page 30.

The Community Browser Views

26

The Community Browser is arranged in an easy to navigate hierarchy. Below the
menu bar is the Index which contains a list of different views:

*  Public - The Public view contains chat rooms divided by topic, which are
accessible to all Internet Phone users. You can switch between the various
topics and chat rooms and call anybody who appears on a user list. Unique
chat rooms found in this view are the on-line conference rooms where you
can have a conversation with several people; see “Conferences” on page 31.

*  Member - The Member view contains chat rooms that you or other Internet
Phone users create. Here, you can also add Web content to make your chat
room morte attractive to other callers with similar interests.

*  Favorites - The Favorites view contains your personal list of chat rooms that
you select, so that you may store them in one place and access them easily.
Your private chat rooms are also listed in this view.

*  Find - The Find view contains a Web page in which you can search for
specific users according to information that you provide.
To browse between the Community Browser views

Click a view in the Index, then do one of the following:

* In the Public and Member views, select a topic in the Topic list, click a chat
room icon in the Chat Room list, and view the room content. Click the Join
button to see the list of users and then select a user to call.

* In the Find view, follow the instructions to perform a user search and then
call the person directly from this page.

To update the Community Browser

Each section of the Community Browser window is updated periodically. You can
update each section manually by right-clicking on the section you want to update in
the Community Browser and choosing Refresh.
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Chat Rooms

The chat rooms in the Community Browser are categorized by topic to attract
users who share similar interests. A chat room contains a list of currently on-line
users who have joined that specific chat room, as well as graphic and textual Web
content pertaining to the room’s subject. The user lists contain the names of the
currently on-line chat room participants, along with their user information and
Internet Phone capabilities.

Periodically, the Community Browser automatically updates itself. It adds new
users who logged on and removes those who logged off.

You can easily join, leave and create chat rooms of your own. After joining a chat
room, you can call other people on the chat room’s user list and communicate with
them using a variety of multimedia features; see “Chapter 6 Multimedia Sessions” on page
41.

Joinin g and Leavin g Chat Rooms

You can view and then choose to join any chat room that appears in the various
views of the Community Browser window. In the 1”7ew mode you can see the chat
room Web content. When you choose to join the room you can also see the users
that are on-line in this room.

NOTE You can restrict access to chat rooms that have content ratings by
exercising parental control; see “Appendix A: Parental Control” on page 53.

To view a chat room

* Click any chat room icon. The Web content appears.
To join a chat room
Do one of the following:

* Click on the blinking Join button (located on the left of the chat room title).

* Choose Join from the Chat Room menu.
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You are now joined to the selected chat room, and you can see the on-line users
and your name is added to the user list. Furthermore, the chat room icon appears
in the Joined Chat Room list at the bottom of the Community Browser. This list con-
tains the icons of all your currently joined chat rooms, regardless of view and topic.

To join more than one chat room at the same time

Each time you want to join a new chat room, you may keep previous chat rooms
you have joined active. In this way, you will be able to receive calls from people in
chat rooms that you are not currently in. All of your active chat room icons will
appear in the Joined Chat Room list.

1 Click the Join button to join a chat room. The chat room icon is added to
the Joined Chat Room list.

2 Browse the hierarchy of the Community Browser window and click another
chat room icon.

3 Repeat steps 1 and 2 each time you want to join another chat room.
To leave a chat room
Do one of the following:

¢ Choose Leave from the Chat Room menu to leave the current chat room.

* Select a chat room icon from the Joined Chat Room list. Click the Leave
button.

* Select a chat room icon from the Joined Chat Room list. Right-click on it
and choose Leave.

When you leave a chat room, its icon is removed from the Joined Chat room list.
Your name is also removed from the user list, and you return to the View mode.
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Creatin g a Chat Room

E3

In Internet Phone Release 5, you can easily create new chat rooms and wait for
others to join.

When you create a chat room, you must choose if it will be Public, which is open to
all Internet Phone users, or Private, which is open only to specific people who know
the room name. If the new chat room is Public, it appears in both the Member and
your Favorites views. If the new chat room is Private, it appears only in your
Favorites view.

To create a public and/or private chat room

1 Choose New... from the Chat Room menu.
The New Chat Room form appears.

2 Enter all of the requested information.

After a short interval, the new chat room will be active. Other users will see your
room after they update the Community Browser window or after they log in at a
different time.

Private Chat Rooms

If you want to conduct private conversations, you can create a private chat room.
This “unlisted” chat room cannot be seen on the Member chat room list, and can
only be accessed by users who know the exact name of the private chat room.

When another person wants to join this private chat room and reach you there,
he/she must open a private chat room with exactly the same name. When a person
joins this chat room, his or her user name appears on the User list and one of you
can double-click the othet’s name to place a call.

To join an existing private chat room

1 Point to Open in the Chat Room menu.

2 In the form, select Private and enter the name of the private chat room that
you want to join.
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The Favorites View

30

The Favorites view contains your personal list of chat rooms that you want to visit
on a regular basis. This list is not limited by number, and you can use it to quickly
join chat rooms and call users. The Favorites view also contains private chat rooms.

To add a chat room to the Favorite view
From the Joined Chat Room list, do one of the following:
¢ Select a chat room icon and then choose Add to Favorites from the Chat

Room menu.

* Seclect a chat room icon, click the right mouse button and then choose Add
to Favorites.

The procedure for joining and leaving chat rooms in the Favorites view is the same
as in any other view; see “Joining and 1eaving Chat Rooms” on page 27.
To automatically join a chat room when you start Internet Phone
Do one of the following:
* Right-click on the Favorite chat room icon representing the chat room that

you want to join when you start Internet Phone. Choose Auto Join.

* Right-click on a chat room icon from the Joined Chat Room list and select
Auto Join. This room is also added to the Favorites chat rooms.

By default, you will join this chat room every time you open the Community
Browser. You can be joined to more than one chat room on startup.
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Conferences

Real-time on-line conferences are becoming popular and Internet Phone Release 5
enables you to join these conferences easily.

To join an on-line conference

1 Select Public in the Index.
2 Click a topic in the Topic list (e.g, General).

3 Click the Conference icon in the Chat Room list.

You have now entered the conference room via the VocalTec Conference Server!

A participant list displays the names of all the
current conference participants. The name of the current speaker is highlighted in
real-time. Only one person at a time can speak.

Follow the on-screen instructions to join the conference. After joining the
conference you can listen and talk to the other conference participants.

1. Subject to availability.
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Chapter 5

Additional Ways to Make a Call

If you want to call someone you know and you already have that person’s
addressing information, you can make a call in a vatiety of other ways:
*  Dialer: Call a regular telephone from your computer.

*  Personal Directory: Reach the people you call most often from your own
Internet Phone Personal Directory.

*  Outgoing and Incoming History: Return calls to users listed in the Incoming and
Outgoing History folders.

»  The Addressing Service - E-mail Address: Contact users directly using their
special Internet Phone address or their e-mail address. Type the address in
the Call Line.

* IP Address: Type an IP address or host name in the Call Line.

*  Session List. Call people whom you spoke with recently by double-clicking
names in the Session list.

*  NetPals: Call Internet Phone users whom you like to speak with regularly by
double-clicking names in the NetPals list.

*  Web Link: Add a hypertext link to your home page that, when clicked, starts
a call. You can also call someone else from a Web site with a similar link.

Callin g a Regular Phone

S

Using the Dzaler, you can call a regular telephone from your computer. The dialer
uses VocalTec’s Telephony Gateway technology, but the gateway service is
provided by an Internet Telephony Service Provider (ITSP). Not all ITSPs are able
to place calls in all parts of the world — choose a service provider that suits your
needs!. The call passes via the Internet through a gateway to the Public Switched
Telephone Network (PSTN). When a user answers the telephone, the two of you
can have a normal conversation. The Message Line displays Internet Phone and
the gateway call progress messages (such as Busy and Invalid Number).

1. Signing up with an I'TSP is optional. The Internet Phone-to-Telephone service is NOT provided
by VocalTec and subject to availability of the service provider.
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The Internet Phone-to-Telephone

Callin g Process

34

s
An Internet Phone user dials a certain T T
phone number with the country code and ;=
makes a connection to a Telephony "
Gateway using the selected Internet e
Telephony Service Provider. %

The gateway validates that the phone
number is within its area code limits.

The gateway dials the phone number and begins transmitting voice to/from
the Internet Phone caller.

The gateway continues with call progress control. It will notify the Internet
Phone caller of any change in the call status.

The Dialer supports Dual Tone Multi Frequency (DTMF) signal transmission to
the gateway, providing touch-tone capabilities and enabling communication with
Interactive Voice Response (IVR) systems. For example, listening to your voice
mail on the telephone.

For more detailed definitions of technical terms, see “Glossary” on page 57.

NOTE You can call a regular phone only if you have installed the software

license and registered with an I'TSP.

To call using the Dialer

1 1In the Internet Phone window, choose Dialer from the Phone menu or click

the Dialer icon. The Dialer window appears.

2 In the Dialer window, select the Internet Telephony Service Provider from

the list (unless you use the default service); see “Choosing an Internet Telephony
Service Provider” on page 12..

Enter the country code, area code and phone number by either manually
typing them on your keyboard or clicking numbers on the dial pad with the
mouse (e.g, for the US 1 212 5551234). No need to use the international
access code. You can easily dial numbers containing letters. When entering
numbers manually, you can enter the number with or without hyphens.
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4 Press the Call button (or your keyboard Return key) to place your call.

The call is routed through the selected Internet Telephony Service.

TIP  If you communicate with an IVR system (such as your telephone
voice mail) with DTMF signals any additional numbers that you enter
after the call starts, appear in the Call Line after the original phone
number.

The Personal Directory

The Personal Directory gives you direct access to the Internet Phone users you call
regularly. Once a person’s name has been added to the directory, simply select a
person and call.

To access the Personal Directory

* Choose Personal Directory... from the Go menu.
The Personal Directory folder appears.
After setting names in your Personal Directory folder, you can easily place calls to

users simply by double-clicking on a uset’s name or right-clicking on a user’s name
and choosing Call from the displayed menu.

Setting names in the Personal Directory folder

During conversation, keep the Personal Directory folder opened to add new names
to it by doing one of the following:

* Drag the User icon from the User Information section on the Internet
Phone window to the Personal Directory folder.

* Drag the current session entry from the Session list to the Personal
Directory folder.

* Drag user names from the Incoming or Outgoing History folders to the
Personal Directory folder; see “The Outgoing and Incoming Call History” on page
36.
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If you wish to keep the Personal Directory folder closed, add names to it by doing
one of the following:

* Right-click on the User icon in the User Information section and choose
Add to Personal Directory from the displayed menu.

* Right-click an entry on the Session list and choose the Add to Personal
Directory command from the displayed menu.

The Outgoing and Incomin g Call History

Internet Phone maintains Owutgoing and Incoming History folders. These folders
contain records of Internet Phone users you have called or those who have called
you, and include the information needed for calling the listed people.

NOTE Internet Phone might not always be able to locate and call a person
from the History folders or the Personal Directory, if that person has
not registered the Addressing Service or if they do not have a fixed IP
address.

To access the Incoming or Outgoing History folder
Do one of the following:

* Choose Outgoing History... from the Go menu to see all the people you
called.

* Choose Incoming History... from the Go menu to see all the people who
called you.

The Outgoing or Incoming History folder appears.
To call a person using the Incoming or Outgoing History folder
Do one of the following;

* Double-click on the person’s name.

* Right-click on a person’s name and choose Call from the displayed menu.
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TIP  When you right-click on a user’s name and select Properties from the
displayed menu, you can see essential information such as the uset’s
name, e-mail address, IP address and unique Internet Phone address,
and more.

The Addressin g Service

&

The Addressing Service is a unique and powerful directory service created
especially for all licensed Internet Phone users.

All Addressing Service subscribers get a simple and unique Internet Phone address
(similar to an e-mail address) that makes it easy and efficient to locate and call
them. Unlike the difficulty of locating non-registered users, having an Internet
Phone address guarantees that you and other registered users can easily be found.

Joining the Addressing Service

If you did not join the addressing service during the Setup process (see “Web Setup”
on page 11.) it is possible to register and join the Addressing Service from within
Internet Phone. To do this, choose Addressing Services from the Help menu and
follow the on-screen instructions.

After registering, you will get an Internet Phone address, and other Internet Phone
users can use this address to call you. People that have joined the Addressing
Service can also contact you using your e-mail address, which you should type
correctly during the registration process in the on-line registration form.

To contact others using their e-mail or Internet Phone address

* Type the Internet Phone address or the e-mail address of the person you
want to call in the Call Line, and then click the Call button.

TIP  Send your unique Internet Phone address to others so they can use it to
call you. To see what it is, choose Preferences from the Options menu,
click the User icon, and then click the User Information tab.
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IP Address

Each Internet host is assigned a unique 32-bit address, which is its IP Address, and
is used in all communication with that host. Usually, LANs have fixed IP addresses,
but most individual Internet users do not. If another user has a permanent IP
address, you can call him or her directly, without having to use the VocalTec
Community Browser.

To call directly using an IP address

* Type the person’s IP address in the Call Line and click the Call button.

* An IP address has the following format: xxx.xxx.xxx.xxx , where xxx is a
number from 0 to 255.

* Another way to enter an IP address is to type the host name.
For example: john.acme.com

Session List

Use the Session list in the Internet Phone window to return calls or redial to a

@ recent caller. This list displays current incoming and outgoing calls, starting with
the most recent call. Each entry shows the call duration, the name of the person
who called you or whom you called, and the call status.

To return calls or redial from the Session list

1 In the Internet Phone window, click Sessions to display the Sessions list.

2 Double-click the name of the person to whom you want to return a call or
to redial.

TIP  The session list is cleared every time you quit Internet Phone,
but Internet Phone maintains Incoming History and
Outgoing History lists. These lists contain the names of all the
people who once called you or whom you called; see “I'be Ontgoing and
Incoming Call History” on page 36.
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The NetPals list contains entries of other people that you want to call without
browsing through the chat room lists or typing their addressing information each
time.

You can give your NetPals the privilege of overriding the Do Not Disturb state. A
key icon is displayed next to the uset’s entry; see “Appendisc C: Internet Phone Icons” on
page 54.

To initiate a call from the NetPals list

1 In the Internet Phone window, click NetPals to display the NetPals list.

2 Double-click the name of the person whom you want to call.
To add a person to the NetPals list
Do one of the following:

* Drag the person’s icon to the NetPals list.

* Right-click a person’s entry and choose Add to NetPals.
To remove a person from the NetPals list
* Select the person’s entry and press the Delete key on your keyboard.
* Right-click the person’s entry in the NetPals list and choose Remove from
List. To remove all NetPals from the list, right-click an entry and choose
Clear AlL
To permit a specific NetPal to override the Do Not Disturb mode

Do one of the following:

¢ Choose User from the Phone menu and check the Override Do Not
Disturb menu command.

* Right-click the person’s entry in the NetPals list and check the Override Do
Not Disturb option.
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Callin g Throu gh a Web Link

40

Internet Phone works with Internet Explorer and Netscape Navigator browsers to
enable you to make a call from a Web page by clicking a hypertext link. You can
also create links to your IP address, e-mail address or Internet Phone address, and
add them to your home page. Internet Phone users who browse your page can call
you by clicking those links.

For example, if you have joined the Addressing Service, you can create a link to call
you by your Internet Phone address. Add the following line to your home page
HTML code:

<A HREF=iphone:myname@internetphone.com>Call me with Internet Phone 5</A><P>

where myname@internetphone.com  is your Internet Phone address.



Chapter 6
Multimedia Sessions

In addition to its conversational capabilities, Internet Phone Release 5 provides a
complete interactive environment to enhance your conversations.

The full suite of multimedia features include:

* Live Motion Video
*  Voice Mail
* Data sharing: Whiteboard, Text Chat, File Transfer

NOTE To use the Internet Phone data sharing features with another user, the
other user must have Internet Phone Release 4 or higher.

Video Sessions

You and your partner can view each other in live motion video while conducting an
Internet Phone conversation. If you have the proper video equipment, you can
both transmit and receive video. Your partner will receive your transmitted video
even if he/she does not have a video device.

The Self View Window

The Self View window displays your picture (or the focus
of your installed video device). The person that you call will
see the contents of your Self View window on his/her screen.

For instructions on setting up the Self View window,
see “Setting Up the Video” on page 14.

To open the Self View window

Check the Self View command from the Options menu.
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TIP If Self View is selected when you quit Internet Phone, the video window
will be displayed automatically when you run Internet Phone again.

Transmittin g and Receivin g Video

W After completing the Video setup, click the Video icon in the Internet Phone
i window to automatically transmit and receive video each time you begin a

m .

] conversation.

Received video frames are viewed on the main window, replacing the Animated
Assistant. You can detach the Remote 17ew window and enlarge the video size of
your received video frames.

To enlarge the size of your received video frames

1 Choose Preferences from the Options menu. Select the General icon and
click the Display tab.

2 Check the Detach Remote View checkbox and click OK. The remote user
video is displayed in a separate window next to the Internet Phone window.

3 Point to the right bottom of the Remote View window and drag your mouse
to resize the window. The video is resized.

The Video Icons

% The Video icons on the Internet Phone window show you the status of your

M transmitted and received video frames during a conversation; the camera icon
shows if you can transmit video and the monitor icon displays if you can receive
video from others; see “Appendisc C: Internet Phone Icons” on page 54.

TIP  You can see other users video capabilities on the Community Browser
user list. The video icons indicating the capability: a camera icon
indicates video transmitting capabilities, and a monitor icon indicates
video receiving capabilities.

While talking, you can disable either or both receiving and transmitting video by
clicking on the buttons. If one of the buttons is dimmed, it means that the other
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user has either disabled receiving or sending video or does not have these

capabilities.

Sendin g and Receivin g Voice Mall

With Internet Phone you can send and receive voice mail, edit your messages, and

send text messages as well.

These activities are done via the Internet Phone Voice Mail window shown here.
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You receive your voice mail in your regular e-mail program. To listen to incoming
messages, use the Voice Mail Player included with the Internet Phone software.

NOTE You can send the Voice Mail Player to other users so that they can listen
to your messages, even if they do not have Internet Phone; see “The 1/vice

Mail Player” on page 48.

To access the Internet Phone Voice Mail

Do one of the following:
Click the Voice Mail tool button in the Internet Phone window.

Choose Voice Mail... from the Phone Menu.

Right-click a user’s entry (e.g,, in the Community Browser, NetPals or
Session list etc.) and choose Send Voice Mail.

43



Chapter 6 Multimedia Sessions

Sendin g Voice Mail and Text Messa ges

The following steps lead you through the process of creating and sending a new
voice mail message:

* Type the recipient e-mail address

* Enter a subject (optional)

* Record your message

* Add a text message (optional)

* Add a file attachment (optional)

* Send your voice mail message with text and file attachments

* Attach the Voice Mail Player (optional)
To select recipients and secondary recipients
Do one of the following:
* Type the e-mail address of the person to whom you want to send voice mail

in the To: box. Type the e-mail address of the secondary recipient in the cc:
box or of a hidden secondary recipient in the bcc: box.

TIP  Bcc means blind carbon copy. Primary and secondary recipients will not see
the bce names. If you type more than one name in the bece: text box,
recipients will see only their own name in that box; that is, their names
are hidden from each other.

* Click the To: button. From the Personal Directory folder, select a person
and click the Open button at the bottom of the dialog box. If the selected
person has a valid e-mail address, it is displayed in the To: box in the
Internet Voice Mail window. For secondary recipients click the cc: or the
bcce: buttons and select people from the Personal Directory folder.

N O TE You can type more than one address into each text box.
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To Enter a subject

To title your message or briefly describe the subject, type this information into the
Subject box in the Address panel. This information is optional.

To record a message

1 Click the Record button on the Tape Recorder Controls. The Message Line
displays the message Recording. ...

2 Speak into the microphone to record your speech.

3 When you speak, make sure that the Record Leve/ Bar is always bright green
and does not reach deep into the red zone. If it does, you are speaking too
loudly.

4 The number to the right of the Time Barindicates the length of your
recorded message.

5 Click the Stop button on the Tape Recorder Controls.

|
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To play back a message
* Play back the recorded message using the Pause, Rewind, Forward and
Play buttons.
* The Message Line displays the message Playing. ...
You can adjust the volume level using the Volume Slider. Drag the slider to the

right to increase the volume.

During playback, the number to the left of the Time Bar shows the elapsed playing
time of your recorded message.

TIP  If you do not hear yourself through your speakers during playback,
check the microphone connection and sound card configuration.
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To add a text message to your voice mail

* Type your message into the text box just as you would with a regular e-mail
message. Use the scroll bar to scroll text.

To add a signature to the end of your message

1 Choose Preferences from the Options menu, click the Voice Mail icon and
the Signature tab.

2 Select Always Sign Your Message.

3 In the Your Signature box, type the signature and click OK.
To attach a file(s)

Click the Attach button and choose File... to open the Select File To Attach dialog
box. Do one of the following:

* Seclect the file you want to attach and click the Open button.

*  Double-click the file you want to attach.

The total amount and size of attached files is indicated on the right side of the File
Attachment panel.

TIP  You can send the Voice Mail Player to recipients who do not have
Internet Phone; see “T'he 1vice Mail Player” on page 48.

It is recommended that you compress all non-text files before attachment.
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To remove a file(s)

1 If you decide not to send a file, you can remove it. In the file list, select the
file you want to remove.

2 Press the Delete key.

To send your message

¢ C(lick the Send button.

The Progress Bar and Message Line indicate that the voice mail is being sent.

TIP  The Send button switches to Cancel while sending; click it to stop the
sending process.

Retrievin g a Voice Mail Messa ge

The voice mail message may be composed of a text message, file attachment(s)
and/or voice message; all are easily retrieved using your mailer application.

A voice mail that was sent to you appears as an e-mail message with an attached
voice file (Voice. VMF).

To listen to your voice mail message
Do one of the following:

* Double-click the voice file attachment (if your e-mail program enables you
to open an attachment this way).

* Save the voice file attachment to your hard drive according to your mailer
application’s method. Double-click the voice file to open the Voice Mail
Player and play the message.

Use the Tape Recorder Controls Play, Forward, Rewind and Stop to replay the
message.
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The Voice Mail Player

You can send the Voice Mail players to Macintosh and Windows users, enabling
even users who do not have the Internet Phone software to listen to your
messages.

Attach the Voice Mail Player to your message by clicking the Attach button and
choosing Attach PC Player (for Windows users) or Attach Mac Player (for
Macintosh users) and send your voice out to family, friends and colleagues. After a
quick installation process, they can listen to your message and save the player for
future voice mail. To assist these recipients, they will receive installation
instructions together with the Voice Mail Player.

Data Sharin g

48

You can share text and graphics with another person by using the Whiteboard
workspace, send and receive textual messages using the Text Chat window and
transfer files to each other using the File Transfer feature.

All data sharing activities - Whiteboard, Text Chat and File Transfer - constitute a
single data sharing session. Either you, or the person you are currently connected to,
can start a data sharing session.

N O TE You can participate in only one data sharing session at any one time and
share data with only one user at a time.

If you are engaged in a data sharing session with one user, and you want to share
data with another user, you must end the data sharing session with the first user
and start another one with the other.

To start a data session with another user
Do one of the following:

# ¢ Click on the Share Data icon at the bottom of the Internet Phone window.
¢ Select User from the Phone menu and check the Share Data command.

This action will terminate any ongoing data sharing activities which involve other
users.
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The Internet Phone Whiteboard

=

The Internet Phone Whiteboard is a virtual workspace for sharing text, graphics and
data in real-time with another user. The Whiteboard is ideal for visually describing
ideas and concepts. You can import or capture graphics from other software or
from your Web browser and show scanned photographs of family and friends.

Or, if you are using the Whiteboard to work collaboratively, you and the other user
can use the Whiteboard tools to annotate (i.e., make comments or notes) on the
contents of the workspace, without marking or changing the image or document.
Some of the supported tools are: shape tools (arrowhead lines, rectangles,
diamonds, ellipses), highlighters, pens, line draw and freehand erasers. Every
change you make on your side of the Whiteboard will appear shortly on the other
user’s screen, and vice versa.

To access the Internet Phone Whiteboard

During an Internet Phone conversation, do one of the following to establish a
whiteboard session:
* In the Internet Phone window, click the Whiteboard tool button.

* In the Internet Phone window, choose Whiteboard... from the Phone
menu.

Internet Phone Whiteboard is displayed and you can start sharing data.
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Using the Shared Whiteboard

All the tools for the Whiteboard are displayed in the side bar of the screen. They
can also be activated from the Tools menu. Experiment by drawing a line, changing
the color or thickness of the pen, adding text, drawing shapes, etc.

Erasin g Annotations

Internet Phone Whiteboard assigns ownership of annotations to the local machine
on which they were made. To erase annotations do any combination of the
following:

* Clear only your annotations by clicking the icon on the toolbar.

* Clear all the annotations on both participants’ machines by clicking the icon
on the toolbar.

¢ Use the freehand erase tool for minor errofs.

TIP  The Erase tool, Clear My and Clear All operations only clear
annotations. None of them affect images or objects in the frame.

Capturin g Regions

Frx
ko

Internet Phone Whiteboard enables you to “snap” or capture any part of the
Windows desktop or windows themselves.

i

To capture a region of the screen

1 Clear all the marks from the Whiteboard workspace.

2 Click the Capture Region icon; the Whiteboard screen will disappear,
returning to the desktop or a previously opened application.

3 Drag the dotted line box over the region you want to capture.

4 Release the left mouse button and you will return to the Whiteboard frame;
the captured region will be indicated by a dotted line box. Position the
region within the workspace by moving the mouse.

5 Click the left mouse button to place the region in the workspace.
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To move the region
Do one of the following:

* Click the Object Select button.
* Click on the image. The image is now surrounded by a gray border.

* Drag the object around the whiteboard workspace.
To delete the image

1 Click over the image. The image is now surrounded by a gray border.

2 Press the Delete key or cut the image to the clipboard using the Cut
command from the Edit menu.

To save your work
Do one of the following:

¢ C(lick the Save icon.
¢ Select Save from the File menu.

Frames are saved in “Conference” file format and the file names have a .CFR
extension.

File Transfer

Ga During a conversation, you may want to exchange files. To send any file from your
hard disk or local network to the other user, do one of the following:
* Click the File Transfer tool button in the Internet Phone window.
* Choose File Transfer... from the Phone menu.

A dialog box appears from which you can select the file to transfer. Click the Open
button. The Transfer File dialog box prompts you to Compress File Before Sending. 1t is
recommended you check this option. Click the OK button in the Transfer File
window to send the selected file to the person you are speaking with.
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Text Chat
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Either you, or the person you are currently connected to, can start a text chat
session. This feature is useful when the Internet connection is slow, or you cannot
hear each other well.

To access the Internet Phone Text Chat window
Do one of the following:

¢ (Click the Text Chat tool button in the Internet Phone window.

¢ Choose Text Chat... from the Phone menu; Internet Phone Text Chat
session and the Text Chat window open simultaneously on your screen and
the other person’s screen.

* Type your message in the line at the bottom of the window and then press
the Enter key to send it. The message is added to the window above, and
the other user can reply.

TIP  You can copy and paste text to and from the Text Chat window
using its Edit menu commands. You can also save your Text Chat
session as a text file by choosing Save from the Text Chat window
File menu.
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Appendix A: Parental Control

Internet Phone Release 5 provides the option of restricting access to certain chat
rooms.

To enable Parental Control

1 In the Internet Phone window, choose Preferences from the Options menu
and then click the Community Browser icon.

2 Click the Enable Parental Control button.

3 Type your supervisor password, confirm it, and then click OK.

Parental control is now enabled. When you click a chat room icon that has
been defined as offensive or problematic, you will be prompted to type the
supervisor password.

To disable Parental Control

1 In the Internet Phone window, choose Preferences from the Options menu
and then click the Community Browser icon.
2 Click the Disable Parental Control button.

3 Type your supervisor password and click OK.

Appendix B: Troubleshootin g

Frequently Asked Questions

After I perform an audio test, other users still cannot hear me speak. How
can I make them hear me?

1 Point to Audio in the Options menu and then choose Audio Mixer...
In the Volume Control dialog box, choose Properties from the Options
menu.

3 In the Properties dialog box, select Recording in the Adjust Volume For
area. Click the OK button.

4 In the Recording Control dialog box, click the Advanced button.

5 In the Advanced Controls for Microphone dialog box, select1 AGC for
Waveln and click the Close button.
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How come I cannot redial people from the Session list?

If a person you are trying to redial from the Session list has not registered for the
Addressing Service or if he/she is off-line, Internet Phone might not always be
able to find and call that person.

Technical Support

The Support Wizard

You can get additional help and technical support and send a technical support
request by doing the following:

1 Choose Support Wizard from the Help menu.

The Internet Phone Support Wizard window appears.
2 Click the Technical Support button.
3 Follow the on-screen instructions.

You can send the request form with a detailed description of your question or
problem to VocalTec’s Technical Support. The Support Wizard sends together
with your request an essential information about your system that assists our
support engineers to easily find a solution to your problem or question.

Appendix C: Internet Phone Icons
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This chapter describes all Internet Phone icons, control tools and symbols in the
Internet Phone window. Use it as a quick reference guide while working with
Internet Phone.
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Internet Phone Window
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Bandwidth

Bandwidth refers to the capacity to move information. In telecommunications,
bandwidth is the width of a communications channel. In digital communications,
bandwidth is measured in bits per second (bps).

bps

Abbreviation for Bifs per Second, which is the unit of measure for the speed of data
communications. Virtually all digital transmission circuits from WANSs to LANs to
Internet are defined in bits per second.

C
CODEC

Acronym for Compression/ Decompression. A codec is a method of digital compression
and decompression which enables you to send and receive audio and video.
Internet Phone Release 5 supports several different codecs. Quality and video
speed varies among the codecs. Available bandwidth and number of lost packets
can also affect the quality.

Compression

Reduced form of the information, but not the information itself. Compression
saves transmission time or capacity.

D
DTMF

Acronym for Dual Tone Multi-Frequency, which describes push-button or touchtone
dialing. Each push-button on the telephone makes a combination of one high
frequency tone and one low frequency tone. From these tones, the

Signal Processing Card determines the dialed number.
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F

Full-Duplex

Simultaneous transmission in two directions. Using full duplex transmission, both
parties can speak at the same time. Actually, no phone communications are really

full-duplex on a point to point connection; the line switches direction so fast that

you cannot tell the difference.

G

Gateway

A gateway is an entrance and an exit into a communications network. For example,
a gateway can bridge the PSTN (Public Switched Telephone Network) with the
Internet, or an Intranet. It’s the link which connects both communication mediums
and allows telephone-to-telephone calls via the Internet.

H.323

The H.323 specification defines packet standards for terminals, equipment and
services for multimedia communications over LANs.

Half-Duplex

Data transmission in two directions, but not at the same time (such as
speakerphones and CB radios).

Interactive Voice Response

Interactive Voice Response, or II'R is a technology by which you can access
functions of a remote computer by using the keypad on your telephone. For
example, a company using IVR may greet a telephone call with a message like,
“Welcome to VocalTec Communications Ltd. For the sales department, please dial
1. For customer support, please dial 2... Please enter the phone number you wish
to dial”..., etc. You respond to the message’s prompts by pressing keys on your
telephone’s touch keypad.
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Internet

The Internet is a worldwide network of many smaller networks and services, such
as the World Wide Web, e-mail, FTP, Usenet, Gopher...etc.

Internet Telephony

Internet Telephony is a technology that lets you make voice phone calls over the
Internet. VocalTec’s Internet Phone uses this technology.

IP Address

An IP address is a unique, 32-bit number for a specific TCP/IP host on the
Internet. IP addresses are normally written in dotted decimal form such as
128.127.50.224. A host uses a fixed IP Address as identification by the other
equipment in the Network.

Intranet

A private network that uses Internet software and Internet standards like TCP/IP.
ISP

Acronym for Internet Service Provider, a for-profit organization supplying
inter-connection between an Internet Access Point and end users. ISPs usually
offer one or more methods for accessing the Internet, such as dial-up serial
connections, ISDN, and T1.

ITSP

Acronym for Internet Telephony Service Provider, a for-profit organization supplying
Internet Telephony service that lets you make voice phone calls over the Internet.

L
LAN

Acronym for Local Area Network, a short distance data communications network
that links together computers and peripheral devices (such as printers) under
standard control.
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P
PSTN

Acronym for Public Switched Telephone Network, the telephone network that connects
all users.

PPP

Acronym for Point-to-Point Protocol, PPP is the Internet standard for transmission of
IP packets over serial lines.

S
SLIP

Acronym for Serzal Line Internet Protocol, which is currently a de facto standard,
commonly used for point-to-point serial connections running TCP/IP. It is not an
Internet standard; see “PPP”.

TCP

Acronym for Transmission Control Protocol, a protocol for verifying correct data
delivery between two systems. TCP detects errors, or lost data, and triggers
retransmission until the destination receives the correct data. TCP generally uses
the IP protocol to transmit the information.

TCP/IP

Acronym fort Transmission Control Protocol/ Internet Protocol, a networking protocol
that provides communication across interconnected networks, between computers
with diverse hardware architectures, and between various operating systems.

w
WAN

Acronym for Wide Area Network, a communications network that covers a wide
geographic area, such as a state or a country.
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SOFTWARE LICENSE AGREEMENT AND LIMITED WARRANTY

READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE USING THE INTERNET PHONE™ SOFTWARE
(THE “PROGRAM"). BY OPENING THIS PACKAGE, YOU INDICATE YOUR COMPLETE AND UNCONDITIONED ACCEPTANCE TO THE TERMS
AND CONDITIONS BELOW. THIS LICENSE AGREEMENT REPRESENTS THE ENTIRE AGREEMENT CONCERNING THE PROGRAM BETWEEN
YOU AND VOCALTEC COMMUNICATIONS LTD. (REFERRED TO AS “LICENSOR”), AND IT SUPERSEDES ANY PRIOR PROPOSAL, REPRE-
SENTATION, OR UNDERSTANDING BETWEEN THE PARTIES.

1. License Grant. Licensor hereby grants to you, and you accept, a nonexclusive non-transferable license to use the Program, in object code form
only, and the accompanying User Documentation (collectively referred to as the “Software”) only as authorized in this License Agreement. The Soft-
ware may be used only on a single computer owned, leased, or otherwise controlled by you, or in the event of the inoperability of that computer, on a
backup computer selected by you. Neither concurrent use on two or more computers nor use in a network is permitted without separate authorization
and the payment of other license fees. The Product is licensed for your internal use and the Product or any derivative or by-product of the Product may
not be used by, sub-licensed, re-sold, rented or distributed to any other party. You agree that you will not assign, sublicense, transfer, pledge, lease,
rent, or share your rights under this License Agreement. You agree that you may not reverse assemble, reverse compile, or otherwise translate the
Software. You agree that you will not use the GSM technology in the Program for wireless transmission between a portable device and a base station
node of a computer network. Upon loading the Software into your computer, you may retain the Program diskettes or CD for backup purposes. In addi-
tion, you may make one copy of the Software on a second set of diskettes for the purpose of backup in the event the Program diskettes or CD are dam-
aged or destroyed. You may make one copy of the User's Manual for backup purposes. Any such copies of the Software shall include Licensor's
copyright and other proprietary notices. Except as authorized under this paragraph, no copies of the Program or any portions thereof may be made by
you or any person under your authority or control.

2. Licensor's Rights. You acknowledge and agree that the Software including the User's Manual are proprietary products of Licensor protected under
U.S. and international copyright, trademark, trade secret and patent laws. You further acknowledge and agree that all right, title, and interest in and to
the Software, including associated intellectual property rights, are and shall remain with Licensor. This License Agreement does not convey to you an
interest in or to the Program, but only a limited right of use revocable in accordance with the terms of this License Agreement. The provisions of the
paragraph shall survive termination of this Agreement.

3. Term. This License Agreement is effective upon your opening this package and shall continue until terminated. You may terminate this License
Agreement at any time. Licensor may terminate this License Agreement at any time and without notice upon the breach by you of any term hereof.
Upon termination, you agree to return to Licensor the Program and all copies and portions thereof.

4. Limited Warranty. Licensor warrants, for your benefit alone, for a period of sixty (60) days from the date of commencement of this License Agree-
ment (the “Warranty Period”) that the Program diskettes and/or CDs are free from defects in material and workmanship. Licensor further warrants, for
your benefit alone, that during the Warranty Period the Program shall operate substantially in accordance with the functional specifications in the
User's Manual. If during the Warranty Period, a defect in the Program appears, you may return the Program to Licensor for either replacement or, if so
elected by Licensor, refund of amounts paid by you under this License Agreement. You agree that the foregoing constitutes your sole and exclusive
remedy for breach by Licensor of any warranties made under this Agreement. EXCEPT FOR THE WARRANTIES SET FORTH ABOVE, THE SOFT-
WARE, AND THE PROGRAM CONTAINED THEREIN, ARE LICENSED “AS IS,” AND LICENSOR DISCLAIMS ANY AND ALL OTHER WARRAN-
TIES, WHETHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. Licensor shall have the right, but not the obligation, to defend or settle at its option, any action at law
against You arising from a claim that your permitted use of the Product and this Agreement infringes any patent, copyright or other ownership rights of
a third party. You agree to provide to Licensor written notice of any such claim within ten (10) days of your notice thereof and provide reasonable assis-
tance in its defence. Licensor has sole discretion and control over such defence, unless it declines to defend or settle, in which case You are free to
pursue any alternative You may have.

5. Limitation of Liability. Licensor's cumulative liability to you or any other party for any loss or damages resulting from any claims, demands, or
actions arising out of or relating to this Agreement shall not exceed the license fee paid by you to Licensor for the use of the Software. In no event shall
Licensor be liable for any indirect, incidental, consequential, special, or exemplary damages or lost profits, even if Licensor has been advised of the
possibility of such damages. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSE-
QUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

The opinions, views, and content expressed in any Internet Phone chat room, public or private, do not necessarily reflect those of Licensor. Licensor
does not undertake to review the content in any way. LICENSOR DISCLAIMS ALL LIABILITY FOR ANY OPINIONS, VIEWS AND CONTENT
EXPRESSED IN ANY CHAT ROOM.

6. Trademark. VOCALTEC® and INTERNET PHONE™ are trademarks of Licensor. No right, license, or interest to such trademarks is granted, and
you shall not assert any right, license, or interest with respect to such trademarks.

7. Miscellaneous. This License Agreement shall be governed in accordance with the laws of the State of Israel. The United Nations Convention on
Contract for the International Sale of Goods is expressly excluded. Licensor may bring suit in any court of competent jurisdiction, to seek relief for any
breach or any infringement by You or any party for whom You are responsible. If any action is brought by either party to this License Agreement against
the other party, the prevailing party shall be entitled to recover, in addition to any other relief granted, reasonable attorney fees and expenses of litiga-
tion. Should any term of this License Agreement be declared void or unenforceable by any court of competent jurisdiction, such declaration shall have
no effect on the remaining terms hereof. The failure of either party to enforce any rights granted hereunder or to take action against the other party in
the event of any breach hereunder shall not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in the
event of future breaches.
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